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Preface

This Quick Start Guide is written for anyone who will be using a VBrick EtherneTV NXG1 
or NXG2 VoD Server. This includes system administrators, network technicians, and others. 
This document explains how to set up and configure the NXG server, how to perform initial 
admin tasks, and how to add storage. For most common tasks like ingesting content, use the 
ETV Portal Server and refer to the ETV Portal Server Administrator Guide for details. You 
can perfiorm most admin tasks using the Portal Server and it is unlikely you will ever need to 
access the Kasenna interface. However, for specific details about the using the Kasenna 
interface, see Viewing the Kasenna Documentation on page 8.
EtherneTV-NXG servers are a key component in VBrick's EtherneTV Media Distribution 
System. The EtherneTV-NXG Video-on-Demand Server provides all standard video-on-
demand (VoD) features including support for MPEG-1, MPEG-2, MPEG-4, and Windows 
Media for maximum flexibility. 

Organization
Getting Started – explains how to unpack and install the server. This includes setup, 
configuration, verification, and other tasks.
Administration – explains administrator tasks common to both NXG1 and NXG2. These 
include content ingestion, file backup, password changes, etc.
Adding Storage - NXG1 – explains how to add storage to NXG1 servers. NXG1 uses 
software RAID for additional storage.
Adding Storage - NXG2 – explains how to add storage to NXG2 servers. NXG2 uses 
hardware RAID for additional storage.
Ingesting Content – provides detailed information on best practices and how content 
ingestion works on NXG1 and NXG2 servers.

Font Conventions
Arial bold is used to describe dialog boxes and menu choices, for example: Start > All 
Programs > VBrick
Courier fixed-width font is used for code elements (C++, HTML) as well as 
filenames, directories, etc.

Bold Courier fixed-width font is used to indicate user input in keyboard 
commands, scripts, etc.

Web addresses are displayed as hyperlinks in the format: http://www.VBrick.com
Italics are used to emphasize specific words or phrases.

Printer-Friendly
Click on a link to print a hard copy of the document. For best viewing, open and resize the 
document using the magnification box at the bottom of the Acrobat Reader window.
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To save or print a PDF document:
1. Click once to open the PDF document in Acrobat Reader.
2. On the Acrobat Reader toolbar, click Save or Print.

NXG_QuickStart.pdf
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Chapter 1

Getting Started
Topics in this chapter

1. Unpack the Server
2. Set up the Server
3. Configure the Server
4. Verify Server Operation

1. Unpack the Server
Each shipment comes with:
• An introductory letter explaining how to get started.
• Product documentation located on a CD-ROM.
• A complete EtherneTV-NXG system.
• All power cords and cables.
• Rack mount kit (Kit-type must be specified at time of purchase).
• Recovery CDs and a floppy disk with NXG license. (Keep in a safe place—do not lose.)
• This NXG Quick Start Guide.

Before You Begin
Make sure that there is a separate PC running Internet Explorer, a PS/2 mouse, a keyboard, 
and a monitor or console. Please obtain the following information for the EtherneTV-NXG 
before applying power to the unit. Note that Unix commands are case sensitive and should be 
entered exactly as shown.

Table 1.  Configuration Information

Note The server comes pre-loaded with the operating system and VOD application 
software. After the system is powered up, a networking wizard will guide you 
through the initial setup.

Note If you have purchased an external storage device such as a SCSI attached DAS it 
must be connected prior to powering up the NXG system.

Information Required Example Write Here

Hostname (that will be assigned to 
EtherneTV VOD)

vbvodnxg
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2. Set up the Server
To set up the NXG server:

1. Connect the monitor, keyboard, mouse and network cables as described below.

Figure 1. NXG1

Figure 2. NXG2

2. If rack mounting the unit, mount the EtherneTV-NXG server in the rack, using the rack 
mount kit provided.

3. Connect the EtherneTV-NXG server to the network by plugging the 10/100/1000 
BaseT Ethernet cable into the Ethernet port 1 (1) on the rear of the unit.

4. Connect the monitor cable to the video port at the back of the EtherneTV-NXG server 
(2) Turn the monitor on.

EtherneTV VOD IP address 172.17.6.55

Default gateway (router) 172.17.1.5

System network netmask 255.255.0.0

Broadcast IP address (NXG1 only) 172.17.255.255

Hostname (that will be assigned to 
EtherneTV VOD)

vbvodnxg

Default network IP address 
(NXG1 only)

172.17.0.0

Domain name vb.loc

DNS IP address 64.80.0.162

Information Required Example Write Here
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5. Connect a mouse and keyboard to the appropriate ports at the back of the EtherneTV-
NXG (3)

6. Plug the EtherneTV-NXG server into a power source, using the power cord provided.
7. Turn the EtherneTV-NXG server’s main power on by pressing the power switch at the 

front of the unit. (4)

Figure 3. NXG1

Figure 4. NXG2

8. The EtherneTV-NXG server will boot and automatically load using the default settings. 
Wait 5–8 minutes for the unit to fully power up. As new hardware is attached (keyboard 
and mouse) the operating systems will automatically find and install the drivers.

9. When booting is complete, type Y and press Enter to continue. Make sure the 
information from Table 1 Configuration Information is available, then press Enter to 
continue.

3. Configure the Server
You will be prompted for the following information. Be sure you have all of the information 
in Table 1 Configuration Information before you continue. When prompted, enter an 
appropriate value for each item and press Enter. Then press y and press Enter again to 
continue. Remember that Unix commands are all lower case and can contain no spaces.; use 
an underscore _ as a separator.

You will be prompted for the following information:
1. The system hostname
2. The system ip address
3. The default gateway ip-address
4. The system netmask
5. The default network ip-address (NXG1 only)
6. The system broadcast address (NXG1 only)
7. The system domain
8. The dns server ip-address
Quit now, if you do not have this information.
Continue?
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Please enter y or n

Verify the Entries
To verify the entries you just made:

1. Review the information you entered. If everything is correct, type Y and press Enter to 
continue. Otherwise, type N and repeat the setup process.

2. When done the EtherneTV-NXG server displays the configuration files it will update. 
Type Y then press Enter to continue. The changes will be displayed for each of the 
following files. Review each, type Y to accept and Enter to continue.

/etc/sysconfig/network

/etc/sysconfig/network-scripts

/etc/resolve.conf

ServerName in httpd.conf

3. When asked if you have completed reviewing the files to be updated, type Y then press 
Enter to continue.

4. Wait several minutes until setup is complete and the following message is displayed: 

Done

Omnibase setup is complete; press enter to continue to login prompt

5. Press Enter and enter the login name and password:
a. At the login prompt, type root and press Enter.
b. At the password prompt, type omnibase and press Enter.

If you encounter an error at any time during set-up. or if the server is moved to another 
network, you must perform the following operation:
6. Rename the setup file as follows: 

root# mv /opt/vbricksetup/.vbrickmbase_is_setup /opt/vbricksetup/
.vbrickmbase_is_not_setup 

7. Reboot the server.
root# reboot

4. Verify Server Operation
To verify that the server is properly installed:

1. Verify that there is an amber link light on the EtherneTV-NXG server’s Ethernet port.
2. From the Linux Administrator command line: Ping the local gateway IP address.

Example: ping 172.17.1.5 (Use your appropriate local gateway IP address.)
3. From a separate PC: Ping the EtherneTV-NXG server from a PC using the EtherneTV-

NXG1 IP address. For example:
ping 172.17.6.55 (Use the IP address of your EtherneTV-NXG server.)

Changing the Domain Name
The IP address of the EtherneTV-NXG server must be entered as a hostname entry in the 
DNS server in order for the NXG server to be recognized by desktop clients through its 
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domain name (e.g. http://vb.loc) rather than the IP address (e.g. http://172.17.6.55). For test 
purposes, an administrator can change the necessary DNS (host) entry in the local PC hosts 
file. Modify the hosts file on the local PC to resolve the EtherneTV-NXG IP address with 
the actual hostname:

To modify the hosts file:

1. Search for the file named hosts on the local PC. If there is more than one file named 
hosts select the one located in the Windows\System or Windows\system32 folder.

2. Modify the file by using the right mouse button to choose Open or Open With and use 
Wordpad or Notepad to make the necessary entry highlighted below in bold.

# Copyright (c) 1993-1999 Microsoft Corp.
#
# This is a sample HOSTS file used by Microsoft TCP/IP for Windows.
#
# This file contains the mappings of IP addresses to host names. Each
# entry should be kept on an individual line. The IP address should
# be placed in the first column followed by the corresponding host name.
# The IP address and the host name should be separated by at least one
# space.
#
# Additionally, comments (such as these) may be inserted on individual
# lines or following the machine name denoted by a '#' symbol.
# For example:
#
#      102.54.94.97     rhino.acme.com          # source server
#       38.25.63.10     x.acme.com              # x client host

172.17.6.55              vbvodnxg1 

Changing the Server Name
NXG1 only. If you are running a network without DNS or if there is no DNS entry for your 
NXG server, then MediaBase XMP web pages will require a '/' character at the end of the url 
in order to load properly.

To correct this, perform the following steps:

1. Edit /usr/kasenna/apache/conf/httpd.conf
2. Find the line that starts with "ServerName"
3. After the "ServerName" token you will see the hostname of the NXG server. Change this 

to the IP address of the server.
For example, if your NXG has a hostname of myNXG2 and an IP address of 
192.168.1.100, your httpd.conf file will have the following: ServerName myNXG2. 
Change this to: ServerName 192.168.1.100

4. After editing httpd.conf restart the MediaBase XMP web server with the following 
commands:
/etc/init.d/Kasenna_Apache stop

/etc/init.d/Kasenna_Apache start
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Changing the Time and Time Zone
When the EtherneTV-NXG is working in conjunction with the EtherneTV Portal Server in 
order for the time to appear correctly, it is necessary to set the time zone to match that of the 
EtherneTV Portal Server. 

Using the GUI Interface
Follow the directions below to edit the /etc/sysconfig/clock file and then make a new soft 
link to:
/etc/localtime

To set the time and time zone with the GUI:

1. From the Linux prompt, type startx and press Enter to launch the Red Hat graphical 
user interface.

2. Open a command line interface from the GUI and type:
/etc/init.d/mediabase stop

3. At the lower right corner of the screen, right-click on the time and select Adjust Date & 
Time.

4.  From the pull-down menu, select the time zone you are in. For example, America/
Detroit, then click Apply and OK to close the window. Adjust the time as necessary.

5. Return to the command line interface and type /etc/init.d/mediabase start
6. At the lower left corner of the screen, right-click on the Red Hat icon, select logout, and 

then click on the Logout button to return to the Linux prompt.

Using the Command Prompt
To set the time and time zone from a Command Prompt:

1. Review the list of time zones in /usr/share/zoneinfo. Find the time zone you want, and 
then enter:
ln -sf /etc/localtime /usr/share/zoneinfo/desiredtimezone

2. For example, to set the time for U.S. East Coast, type:
ln -sf /etc/localtime /usr/share/zoneinfo/EST5EDT
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Chapter 2

Administration
VBrick's EtherneTV-NXG Server has been integrated with the EtherneTV family of 
products including the EtherneTV Portal Server, MPEG-1/2/4 streaming encoders, 
Windows-based desktop computers, and the EtherneTV-STB. The EtherneTV-NXG delivers 
stored MPEG assets as unicast streams (with full VCR-like functionality such as Stop/Pause/
Play/FF/Rew) across an Ethernet network. The EtherneTV-NXG is built on a Dell hardware 
platform. (See Table 1 below for complete details.) Other features include the ability to 
schedule asset playback, asset searching, user and system statistics, and more. The EtherneTV 
Portal Server is required to gain the full benefits of the EtherneTV-NXG server and is sold 
separately.
In order to set up the EtherneTV Portal Server, please follow the directions in the 
EtherneTV Portal Server Administrator Guide. Once the ETV portal server is setup and 
configured, you can access video on the EtherneTV-NXG server through the ETV Portal 
Server web interface. VBrick uses its own software-based components to decode streams on 
the desktop. There is no client-side software to install. The EtherneTV Portal Server 
automatically downloads components to the desktop PC upon the user’s initial access to the 
system. The following table shows all currently supported models.

Table 1.  NXG VoD Server Specifications – All Models

Topics in this chapter

Viewing the Kasenna Documentation
Ingesting Content
Automatic File Backup

Dell 
PowerEdge 
Hardware

Kasenna 
MediaBase 
Software

Operating System Operating System 
Drives

Internal Content 
Drives

External Content 
Drives† 

NXG1 1750 7.0.1 Red Hat 8 1 Drive 2 Drive Software 
RAID0

7 Drive Software 
RAID0

NXG1 1850†† 7.2.1 Red Hat 8 1 Drive 1 Drive 7 Drive Software 
RAID0

NXG1 1850††
(with Fiber NIC)

7.2.1 Red Hat 8 1 Drive 1 Drive 7 Drive Software 
RAID0

NXG2 2650 7.2.0 Red Hat 8 1 Drive 4 Drive Hardware 
RAID5

7 Drive Hardware 
RAID5

NXG2 2850†† 7.2.1 Red Hat Enterprise 
Linux 3

2 Drive Hardware 
RAID1

4 Drive Hardware 
RAID5

7 Drive Hardware 
RAID5

† Up to 4 logical volumes.
†† Denotes current VBrick product.
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Re-Installing the License Key
Changing the Default Passwords
Best Practices

Viewing the Kasenna Documentation
To access the Kasenna documentation:

1. Open a web browser on the VOD administrators PC and type the following URL:
http://vbvodnxg1/mbase/admin/ (In this example vbvodnxg1 is the name or IP address 
of the VoD server. Be sure to include the final slash.)

2. Login with the following credentials:
User Name = admin
Password = admin

3. Once logged in, create a "favorite" or "bookmark" this page.

4. To access the online documentation, select the link Admin Guide. From here you can 
access the Kasenna MediaBase XMP Installation and Configuration Guide and the 
Kasenna MediaBase XMP Administrator's Guide. Follow the instructions in these two 
manuals for system administration and video content management.

Ingesting Content
VBrick strongly recommends that you use the EtherneTV Portal Server exclusively to ingest 
all NXG content. You can FTP pre-recorded content or copy pre-recorded content to the 
ETV Portal Server for easy ingestion to the NXG server. The ETV server periodically (every 
5 minutes) polls certain folders for presence of content and if found ingests the content onto 
multiple NXG servers. This process is called Automatic Content Ingestion or Auto-ingestion. 
The content is placed in a pre-defined sub-folder under the FTP root folder. This pre-defined 
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folder is called the auto-ingest root folder. See Ingesting Content on page 31 for more 
information. See also the ETV Portal Server Administrator Guide.

Automatic File Backup

VBrick VoD servers have separate storage for different content. The operating system, the 
application software, and the database are on dedicated filesystems. The use of dedicated 
drive storage for the operating system and VoD software benefits customers in two ways. 
Firstly, operating system patches or new VoD software updates leave all the content drives 
untouched. Secondly, both VoD servers use a mySQL database to index and manage all video 
content and VoD configuration information. While this database is stored on the operating 
system filesystem, each evening the system automatically backs up the database onto the 
RAID drives. Should the operating system drive fail, the database restore procedure uses this 
backup copy to rebuild the database. The Auto Backup feature is on by default and it is 
recommended that it be left on. However if for some reason it is not required the following 
procedure should be used to turn this feature off. If you get lost during editing press Esc 
twice to exit edit mode. Press ":" to return to command mode.

To turn Auto Backup off:

1. Go to the NXG command line.
2. Type crontab -e at the command line. This puts you into an editor for the crontab (the 

cron table). The editor is the "vi" editor. 
3. Using the down arrow key, scroll down to the bottom of the file. A couple of lines up 

from the bottom you will see two lines:

0       4       *       * /opt/vbricksetup/backup_mediabase_database

0       3       *       * /opt/vbricksetup/clear_old_mbdump_files

4. Cursor up to these lines and comment this section out as follows:
a. Press the i key to go to Insert mode.
b. Type the # key in front of both lines to comment them out.

5. Press Esc, then : to go into command mode. Then enter wq to save the changes and exit 
the editor.

Re-Installing the License Key
The license is pre-installed on the server from the factory. You do not have to re-install this 
license except for system restoration. Should you need to re-install the license, use the 

Note This section describes Automatic File Backup. This procedure backs up the 
database only; it does not backup content. To backup content, use industry-
standard methods keeping in mind that compressed video files will still consume 
considerable resources on disk.

Caution Even with Auto Backup enabled, there are situations where the backup may not 
take place soon enough after file ingestion. Therefore it is highly recommended that 
a separate copy of the original content after ingestion be maintained for at least two 
days until the auto backups are made.
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following steps. A floppy disk is included that contains the license key for the EtherneTV-
NXG server. The key should be added to the /var/kasenna/license.dat file. If this file 
does not exist then the file should be created in the specified path (/var/kasenna). 

To make the floppy disk available to the Linux operating system:

1. From the root type: mkdir /floppy and press Enter.
2. Type: mount –t vfat /dev/fd0 /floppy and press Enter.
3. Type cd /floppy. You will now be able to copy the license file from the floppy with the 

following command:
cp /floppy/license.txt /var/kasenna/license.dat

Changing the Default Passwords
There are five accounts with default passwords that you should change for security. These 
include three linux accounts and two web accounts as summarized in the following table:

To change the password for the root, admin, or vbrickuser linux accounts:

1. Login as root, admin, or vbrickuser from the console or a telnet session.
2. Type the command passwd. Respond to prompts for old and new password.

To change the password for the mbase and admin Mediabase XMP web accounts:

1. Type the command:
/usr/kasenna/apache/bin/htpasswd /usr/mbase/etc/webserver-apache/.htpasswd mbase

or
/usr/kasenna/apache/bin/htpasswd /usr/mbase/etc/webserver-apache/.htpasswd admin

2. Respond to prompts for the new password.

Best Practices
• All assets that are installed into the server should have backup copies available in the 

event of disk corruption. This will allow for an easy restoration of the system.
• StreamPlayerPlus allows the recording of live streams to MPEG-1, MPEG-2 and MPEG-

4 files. Once saved the files can then be installed on the EtherneTV-NXG1 server for 
playback. Make sure the "hinting" option is checked when recording MPEG-4 files.

Account Type User Name Default Password

Linux root omnibase

Linux vbrickuser vbrickuser

Linux admin admin

Web Account mbase mbase-admin

Web Account admin admin
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• When recording MPEG-4 and MPEG-2 files using StreamPlayer Plus software, it is 
advisable to keep the length of the record to under 50 minutes to facilitate creating 
playlists and keep viewing time manageable.

• The controls for MPEG-4 Fast Forward and Rewind are not currently supported; 
however, slide bars are supported and provide the same functionality. 

• As the disks become full, the performance of head seek times diminishes and streaming 
performance may be affected. Purge unnecessary files as appropriate.

• Do not use spaces in filenames. Use underscores; for example: my_history_class.mp4.
• Apple QuickTime 6.5, containing native MPEG-4 support, is the recommended MAC 

desktop player for accessing MPEG-4 files from the EtherneTV VOD NXG. QuickTime 
supports the Seek feature (accessed through a slider-bar) for MPEG-4 streams. Make sure 
Edit > Preferences > QuickTime Preferences > Streaming Transport option is set to 
Automatically determine the best protocol and port ID or "use: UDP, RTSP Port ID 
554".
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Chapter 3

Adding Storage - NXG1
Topics in this chapter

Overview
Installation
Configuration
Best Practices
Troubleshooting

Overview
VBrick’s SCSI-attached ES3 and ES4 external storage arrays are available to NXG1 customers 
to increase video storage or to backup existing content. This section explains the steps 
needed to install, configure, and upgrade an ES3 or ES4 storage array on the NXG1 VoD 
server. (The NXG2 VoD server uses a hardware rather than software RAID controller; see 
Adding Storage - NXG2 on page 21 for more about NXG2.) (If the VoD server you 
purchased from VBrick included external storage, the storage array has already been installed 
and configured, and the information in this chapter does not apply. Be sure to connect the 
external storage to the server before powering on. After the system is powered up, a 
networking wizard will guide you through the initial setup.)

Table 1.  NXG1 Drive Configuration

The NXG1 Video on Demand server is equipped with three internal SCSI drives. Drive 0 has 
a capacity of 36GB and is dedicated for the Linux operating system and the VoD software 
and database. Drive 1 has 300GB and is used for video content storage. The ES3 and ES4 
external storage systems are available in two different versions as shown below:

Dell PowerEdge 
Hardware

Operating System 
Drives

Internal Content 
Drives

External Content 
Drives† 

NXG1 1850†† 1 Drive 1 Drive 7 Drive Software 
RAID0

NXG1 1850††
(with Fiber NIC)

1 Drive 1 Drive 7 Drive Software 
RAID0

† Up to 4 logical volumes.
†† Denotes current VBrick product.

Total Storage Capacity Drive Layout

1.022 TB Seven 146GB drives
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The ES3 and ES4 attach directly to the back of the NXG1 via an Ultra320 SCSI cable and use 
the NXG1’s internal RAID software. When connected to the NXG1, the ES3 and ES4’s 
drives are striped in a RAID 0 configuration to improve performance. However, RAID 0 
does not provide any drive redundancy in the event of a drive failure. For ease of 
administration, the drives on the ES3 and ES4 storage arrays are configured into 1 TB logical 
volumes and show up under the NXG1 directory structure as /content2 and /content3.

Installation
To ensure a successful ES3 and ES4 installation and avoid unwanted 
results, it is critical that users follow the exact syntax and order of 
these steps. As video streaming is interrupted during this installation 
process, users are advised to perform this procedure during non-
business hours.

To install a new array:

1. Unpack the ES3 or ES4 storage unit and install it in a rack in close 
proximity to the NXG1 VoD server. Do not connect the power 
cords or SCSI cable. Verify that the slide switch above the SCSI 
connector on the back of the storage array is in the "up" position.

2. Connect the supplied SCSI cable to the blue connector labeled 
Ultra 320 SCSI on the back of the ES3 or ES4 storage unit as 
shown.

3. Connect the other end of SCSI cable to the SCSI connector 
marked with a symbol on the back of the NXG1 server (Dell 
1850).

4. Plug in both power cords to the ES3 or ES4 unit and turn on both power switches on the 
storage array. Wait several minutes before proceeding to the next section of this 
document.

Configuration
To configured the installed array:

1. Hit the power button on the front of the NXG1 server and wait several minutes for it to 
completely power up.

2. Logon to the system as the root user. The root password is omnibase.
3. To create raidtab, type: touch /etc/raidtab

4. At the system prompt, type startx to launch the Red Hat graphical user interface. Wait 
for the Red Hat GUI to appear.

5. Click on the Red Hat menu icon on the lower left corner of the screen and move up to 
the System Tools > Terminal icon and left click it to launch a terminal window. 

2.044 TB Fourteen 146GB drives

Total Storage Capacity Drive Layout
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6. Partition the external drives. This procedure contains details for an ES3 or ES4 storage 
array with seven or fourteen external drives, respectively.
a. For an ES3 storage array, the seven external drives are named by the Linux operating 

system on the NXG as follows. (If you are installing a fourteen drive ES4 array, the 
drive naming follows the same convention and goes from /dev/sdc through /dev/
sdp.)
/dev/sdc, /dev/sdd, /dev/sde, /dev/sdf, /dev/sdg, /dev/sdh, and /dev/sdi. 

b. Partition each external drive using the fdisk utility. (See http://www.tldp.org/
howto/partition/partition-5.html for more about fdisk.) The following example is 
for /dev/sdc.
• Type fdisk /dev/sdc
• Type p to view existing partitions. (There should be none. Use the d command to 

delete any that exist.)
• Type n to create a new partition.
• Type p to specify a primary partition.
• Type 1 (the number one) to create the first partition on this device.
• Accept the default first cylinder. It should be cylinder 1. (Press enter for default.)
• Accept the default last cylinder. It should be the last cylinder on the disk.
• Type t to change the partition type.
• Type 1 (the number one) to change the type for the first partition on this device.
• Type fd to specify a type of linux RAID auto.
• Type w to write the changes to the partition table.
c. Repeat the steps above for all remaining external drives (/dev/sdd through /

dev/sdi for the ES3 or /dev/sdd through /dev/sdp for the ES4) and then close 
the terminal window.

7. Click on the Red Hat menu icon on the lower left corner of the screen and move up to 
the Accessories > Kate icon and left click it to launch the Kate text editor.
a. Within the Kate application, click on File > Open and type the string /etc in the 

Location window and click the OK button. This will display the contents of the /etc 
directory.

b. Move the horizontal scrollbar, locate the raidtab file and left click on it to edit it and 
click the OK button.

c. If installing a 1TB ES3 storage array, edit this file by appending the following 
lines, exactly as shown below, to the end of the file. The section below is added at the 
bottom of the raidtab file. Then skip Step d and jump to Step e.

raiddev/dev/md0
raid-level0
nr-raid-disks7
chunk-size512k
persistent-superblock0
nr-spare-disks0
    device/dev/sdc1
    raid-disk0
    device/dev/sdd1
    raid-disk1
    device/dev/sde1
    raid-disk2
    device/dev/sdf1
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    raid-disk 3
    device/dev/sdg1
    raid-disk4
    device/dev/sdh1
    raid-disk5
    device/dev/sdi1
    raid-disk6

d.If installing a 2TB ES3 storage array, edit this file by appending the following 
lines, exactly as shown below, to the end of the file. The section below is added at the 
bottom of the raidtab file.

raiddev/dev/md0
raid-level 0
nr-raid-disks 7
chunk-size 512k
persistent-superblock 0
nr-spare-disks 0
    device /dev/sdc1
    raid-disk 0
    device /dev/sdd1
    raid-disk 1
    device /dev/sde1
    raid-disk 2
    device /dev/sdf1
    raid-disk 3
    device /dev/sdg1
    raid-disk 4
    device /dev/sdh1
    raid-disk 5
    device /dev/sdi1
    raid-disk 6
raiddev /dev/md1
raid-level 0
nr-raid-disks7
chunk-size 512k
persistent-superblock 0
nr-spare-disks 0
    device /dev/sdj1
    raid-disk0
    device/dev/sdk1
    raid-disk1
    device/dev/sdl1
    raid-disk2
    device/dev/sdm1
    raid-disk3
    device/dev/sdn1
    raid-disk4
    device/dev/sdo1
    raid-disk5
    device/dev/sdp1
    raid-disk6

e. Click on File > Save icon to save your changes. The click on File > Quit to exit the 
Kate editor.

f. Log out of the Red Hat GUI by clicking on the Red Hat icon on the lower left and 
selecting logout, then click on the logout button.

g. At the command line prompt, type reboot
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8. Wait for the system to reboot and logon as root. Then, depending if you are installing an 
ES3 or ES4 storage array, create one or two filesystem(s) on the new RAID array(s) as 
follows. 
a. Temporarily halt the RAID array by typing: /sbin/raidstop –a /dev/md0. (Do the  

same for md1 if you have a 2TB array.)
b. Type mkraid /dev/md0 to initialize the RAID array. This will take some time. You 

should see output on the console with status such as handling md device /dev/
md0, analyzing super-block, etc. Note: if the external disks already contain a valid 
filesystem, mkraid will refuse to destroy it. Instead, you will see various warnings and 
advice on commands to enter. If you are certain you are willing to destroy the 
contents of the external disks, type mkraid –R /dev/md0 to re-initialize the external 
raid array. (This “reinitialize” step is usually not necessary.) 

c. Format the filesystem by typing the following as appropriate. It may take a few 
minutes to finish (for a 7 drive array).
mkfs.xfs -f /dev/md0 (for a 1TB array)

d. Skip to Step g if you are installing an ES3 1 TB array; if installing a ES4 2TB array, 
proceed to Step e. 

e. type mkraid /dev/md1 to initialize the second RAID array. This will take some time. 
You should see output on the console with status such as handling md device /
dev/md1, analyzing super-block, etc. Note: if the external disks already contain a 
valid filesystem, mkraid will refuse to destroy it. Instead, you will see various 
warnings and advice on commands to enter. If you are certain you are willing to 
destroy the contents of the external disks, type mkraid –R /dev/md1 to reinitialize 
the external raid array. (This “reinitialize” step is usually not necessary.) 

f. Format the filesystem by typing mkfs.xfs -f /dev/md1 This may take a few 
minutes to finish (for a 7 drive array). 

g. Launch the Red Hat GUI and Kate editor as in Step 7 above. Use Kate to edit the file 
/etc/fstab and add the following line at the bottom of the file, then save the file and 
exit the Kate editor.
/dev/md0 /content2 xfs defaults 1 2<cr>

It is important to put a carriage return <cr> at the end of this line by hitting the 
Enter key. If installing a ES4 2TB system, add the following two lines to the bottom 
of the /etc/fstab file, then save the file and exit the Kate editor.
/dev/md0 /content2   xfs defaults   1 2 <cr>

/dev/md1 /content3   xfs defaults   1 2 <cr>

h. Log out of the Red Hat GUI and return to the command prompt.
9. Type cd / to go to the root directory. Type the following to create a mount point for the 

ES3 or ES4 external file system.
mkdir /content2

If installing a ES4 2 Terabyte system, type the following to create two mount points for 
the ES4 external file system.
mkdir /content2

mkdir /content3

10. Mount the new file system by typing mount –a. (Per the /etc/fstab configuration).
11. Verify that you can see the new RAID filesystem(s) on /dev/md0 (and /dev/md1) by 

typing:
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df -h

Examine at the Size of md0 (and md1) to verify that each is approximately 1TB.
12. From a separate Windows PC, go to the Kasenna service admin web page
13. Go to Configure > Filesystems.
14. In the Filesystems box, highlight /content2, then click the Add button which bring up 

the Filesystem Change Required page. Then click on the Change Now, then click OK.
15. You should now see (MB)/content2 under the Filesystems listing. This tells you that the 

/content2 filesystem is now managed by MediaBase.
16. If using an ES4, in the Filesystems Box, highlight /content3, then click Add to bring up 

the Filesystem Change Required page. Then click on Change Now and OK.
17. You should now see (MB)/content3 under the Filesystems listing. This tells you that the 

/content3 filesystem is now managed by MediaBase.
18. You are done. Your ES3 or ES4 installation is now complete.

Best Practices
• The system bootup messages (including SCSI and RAID related messages) can be viewed 

by typing more /var/log/dmesg
• You can find where video content is stored by going directly to the Kasenna Content 

Administration web page and clicking on the Video Find/Modify link. Then click on the 
Find button to bring up a listing of all the stored video content. If you then click on the 
underlined video name, it will show you where the video files are stored, either under
/content (internal storage, /content2 (external storage)
or
/content3 (external storage).

Troubleshooting

Note The NXG1 will use any available disk space to store files, so that new content may 
be added to either the internal or external file systems.

Problem
If the NXG1 server is configured properly and a reboot occurs BUT the power on the ES3 
or ES4 is left OFF the server bootup will fail with the following message:

***Error occurred during the RAID startup 

***Dropping you to a shell: the system will reboot when you leave the shell. 

Give root password for maintenance (or type Control-D for normal startup)

Solution
Power on the ES3 or ES4 before powering on the NXG1 VoD server.
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Problem
If the server is started without the cable connected to the ES3 or ES4 storage unit the 
failure message displayed will be: 

Starting up RAID devices: md1 md0 /dev/md2:invalid argument /dev/md2 must be 
a nonpersistent RAID0 or LINEAR array!

***Error occurred during the RAID startup

***Dropping you to a shell: the system will reboot when you leave the shell.

Give root password for maintenance (or type Control-D for normal startup)

Solution
Make sure the SCSI cable to the ES3 or ES4 is connected before powering on the NXG1.

Problem
If the NXG1 server is not configured properly and you reboot the system, the server 
bootup will fail with the following message:

***Error occurred during the RAID startup 

***Dropping you to a shell: the system will reboot when you leave the shell. 

Give root password for maintenance (or type Control-D for normal startup)

Solution
Enter the root password. Use vi to confirm /etc/fstab and /etc/raidtab were set up 
properly. Confirm /content2 (and /content3) were created. When done type exit to 
reboot. If you still have problems, contact VBrick Support Services.
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Chapter 4

Adding Storage - NXG2
Topics in this chapter

Overview
Configuration
Detecting a Failed Drive
Replacing a Failed RAID1 Drive
Replacing a Failed RAID5 Drive
Best Practices
ES3/4 Status LEDs

Overview
VBrick’s SCSI-attached ES3 and ES4 external storage arrays are available to NXG2 customers 
to increase video storage or to backup existing content. This section explains the steps 
needed to install, configure, and upgrade these storage systems on the NXG2 Video on 
Demand server. The NXG2 VoD server is equipped with 6 internal SCSI drives. Drives 0 and 
1 have a capacity of 146GB each and are dedicated for the Linux operating system and the 
VoD software and database. This combination gives the NXG2 876GB of total internal 
storage. (If the VoD server you purchased from VBrick included external storage, the storage 
array has already been installed and configured, and the information in this chapter does not 
apply. Be sure to connect the external storage to the server before powering on. After the 
system is powered up, a networking wizard will guide you through the initial setup.)

Table 1.  NXG2 Drive Configuration

VBrick offers the two different versions of the ES storage array, the 1 TB ES3 and the 2 TB 
ES4. These products are based on Dell’s PowerVault 220S storage system. To improve 
streaming performance and video storage flexibility, the 2TB ES4 storage array is configured 
as two separate 1TB logical volumes. The capacity and drive layout of the ES3 and ES4 
external storage systems are shown below:

Dell PowerEdge 
Hardware

Operating System 
Drives

Internal Content 
Drives

External Content 
Drives† 

NXG2 2650 1 Drive 4 Drive Hardware 
RAID5

7 Drive Hardware 
RAID5

NXG2 2850†† 2 Drive Hardware 
RAID1

4 Drive Hardware 
RAID5

7 Drive Hardware 
RAID5

† Up to 4 logical volumes.
†† Denotes current VBrick product.
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The ES3 and ES4 attach directly to the back of the NXG2 via an Ultra320 SCSI cable. The 
use of a software RAID 5 array provides excellent performance for streaming video while 
also protecting against data loss if a single drive in the RAID 5 array fails. In the case of a 
single drive failure, video streaming will continue, although total streaming bandwidth and 
throughput will be slightly reduced.

Drive Layout
The following diagram shows the SCSI ID numbers and their associated hard drives. For the 
2TB ES4 storage unit, Vbrick has logically divided the chassis into two separate 1TB RAID 5 
arrays, the first comprised of drives 0 through 5 + 8, and the second drives 9 through 15. The 
SCSI ID information will be used in the Configuration section of this document. 

Installation
To ensure a successful ES3/ES4 installation, it is critical that users follow the exact syntax and 
order of these steps. As video streaming is interrupted during this installation process, users 
are advised to perform this procedure during non-business hours.

To install an ES3 or ES4 device:

1. Unpack the ES3 or ES4 storage unit, attach the rack mount kit and install it in a rack in 
close proximity to the NXG2 VoD server. Do not connect the power cords. Connect the 
supplied SCSI cable to the connector labeled "Ultra320 SCSI" located near the middle of 
the ES3/4 storage unit. Verify that the slide switch is in the "up" position on the module 
next the SCSI card.

.

Model Total Storage Capacity Drive Layout

ES3 1.022 TB Seven 146GB drives

ES4 2.044 TB divided into two 
1.022 TB logical volumes

Fourteen 146GB drives
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2. Connect the other end of SCSI cable to the top right SCSI connector (Port 2) on the four 
port SCSI card in the back of the NXG2 server. If connecting a second ES3/4 storage 
unit, use the top left SCSI connector (Port3).

3. Plug in both power cords and turn on both power switches on the ES3/ES4. Wait several 
minutes before proceeding to the next step.

Configuration
This procedure explains how to configure external storage on the Dell 2850 with software 
RAID. 

To configure software RAID on a Dell 2850:

1. Power on the 2850 server.
2. Allow the system to boot up completely.
3. Login as root.
4. Run software RAID configuration scripts as followed:

a. For 1TB of external storage, run /opt/vbricksetup/configure_external1
b. For 2TB of external storage, run /opt/vbricksetup/configure_external1, follow 

the prompts, and then /opt/vbricksetup/configure_external2
c. For 3TB of external storage, run /opt/vbricksetup/configure_external1 then /

opt/vbricksetup/configure_external2 and then /opt/vbricksetup/
configure_external3

d. For 4TB of external storage, run /opt/vbricksetup/configure_external1 then /
opt/vbricksetup/configure_external2, then /opt/vbricksetup/
configure_external3 and then /opt/vbricksetup/configure_external4.

5. After running the external storage configuration scripts, the system will build the RAID5 
arrays. This can take up to 3 hours. To monitor progress, type cat /proc/mdstat. The 
output will indicate the percent complete for each RAID array.

6. After all the RAID arrays have been built, type init 6 to reboot the server.
7. Open a MediaBase management web page by going to the following URL from a 

browser:
http://serverIPorHostname/mbase/admin/

8. Go to the file system configuration page by clicking Configure > Filesystem.
9. A new filesystem will be listed in the Filesystems list for each terabyte of storage that has 

been added. These filesystems are named external1, external2, external3, and 
external4. For each Terabyte of storage added:
a. Select an unmanaged content filesystem from the list.
b. Click the Add button.
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c. "(MB)" should now appear before the filesystem to indicate that it is now being 
managed by the VOD system.

10. The external storage is now available for new asset storage. 
11. Finish by verifying that the external1 and /external2 (if used) directories are listed on 

the Kasenna Monitor > Storage page by highlighting the System Asset Group field and 
seeing these filesystems appear under the Storage List.

Detecting a Failed Drive
Example 1 – Status Shows Healthy Arrays

To monitor the health of drives in the RAID array, look at the file /proc/mdstat. Here is an 
example of five healthy RAID arrays:

[admin@NXG2-2850 etc]$ cat /proc/mdstat
Personalities : [raid1] [raid5]
md7 : active raid5 sdt[6] sds[5] sdr[4] sdq[3] sdp[2] sdo[1] sdn[0]
      860247552 blocks level 5, 128k chunk, algorithm 2 [7/7] [UUUUUUU]

md6 : active raid5 sdm[6] sdl[5] sdk[4] sdj[3] sdi[2] sdh[1] sdg[0]

      860247552 blocks level 5, 128k chunk, algorithm 2 [7/7] [UUUUUUU]

md5 : active raid5 sdc[0] sdf[3] sde[2] sdd[1]

      430123776 blocks level 5, 256k chunk, algorithm 2 [4/4] [UUUU]

md1 : active raid1 sdb3[1] sda3[0]

      123828928 blocks [2/2] [UU]

md0 : active raid1 sdb1[1] sda1[0]
      152512 blocks [2/2] [UU]
unused devices: <none>

Example 2 – Status Shows Failed Drive in RAID5 Array

Here is an example with a failed drive in the RAID5 array md5. Note that sdd is missing from 
md5; 3/4 is shown rather than 4/4; and U_UU is shown rather than UUUU. A similar output 
would appear for a failed RAID1 drive in md0 or md1.

[admin@NXG2-2850 admin]$ cat /proc/mdstat
Personalities : [raid1] [raid5]
md7 : active raid5 sdn[0] sdt[6] sds[5] sdr[4] sdq[3] sdp[2] sdo[1]
      860247552 blocks level 5, 128k chunk, algorithm 2 [7/7] [UUUUUUU]
md6 : active raid5 sdg[0] sdm[6] sdl[5] sdk[4] sdj[3] sdi[2] sdh[1]
      860247552 blocks level 5, 128k chunk, algorithm 2 [7/7] [UUUUUUU]
md5 : active raid5 sdc[0] sdf[3] sde[2]
      430123776 blocks level 5, 256k chunk, algorithm 2 [3/4] [U_UU]
md1 : active raid1 sdb3[1] sda3[0]
      123828928 blocks [2/2] [UU]
md0 : active raid1 sdb1[1] sda1[0]
      152512 blocks [2/2] [UU]
unused devices: <none>

Note The MediaBase VoD software automatically determines the best storage placement 
for any new video asset added to the system. This means that internal NXG2 
storage may be used first before the external ES3 or ES4 storage is utilized.
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Replacing a Failed RAID1 Drive
There are two drives in the array, and the exact commands you enter depend on which drive is 
being replaced. Use care when partitioning the array. A failure to partition the drive correctly 
may require a complete re-install. When partitioning the array, type a question mark (?) at the 
fdisk prompt to see a list of commands. Type man fdisk at the Linux prompt for help using 
the fdisk disk partitioning utility. For more about fdisk see http://www.tldp.org/howto/
partition/partition-5.html. Contact VBrick Support Services if you need help. While running 
the following procedure, you can safely ignore the following informational message:

The number of cylinders for this disk is set to 36472. There is nothing wrong 
with that, but this is larger than 1024,and could in certain setups cause 
problems with: 1) software that runs at boot time (e.g., old versions of 
LILO)2) booting and partitioning software from other OSs (e.g., DOS FDISK, OS/

2 FDISK)

Replacing Failed Drive1
To replace a failed drive in a RAID1 array:

1. Power down (type init 0 and wait for the system to shut down).
2. Remove failed drive from the system
3. Add a replacement drive.
4. Power up and login as root.
5. Copy the partition table from the good drive to the replacement as follows:

a. Type fdisk /dev/sdb to view the partition table.
b. Type p to print the partition table for /dev/sdb.
c. Type q to quit fdisk.
d. Type fdisk /dev/sda to write the partition table on the new drive.
e. Type p to print the partition table for /dev/sda.

6. At the prompt, type d to delete existing partitions (up to 4).
Command: d

Partition number (1-4): 1

Command: d

Partition number (1-4): 2

Command: d

Partition number (1-4): 3

Command: d

Partition number (1-4): 4

7. At the prompt, type n to create the first new partition.
Command: n

   e   extended

   p   primary partition (1-4): p

Partition number (1-4): 1

First cylinder: 1 (Start cylinder for first partition.)
Last cylinder: 19 (End cylinder for first partition. Must agree with /dev/sdb above.)
Command: t (Set partition type.)
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Partition number (1-4): 1

Hex code: fd (Linux RAID filesystem.)
Command: n (Create second new partition.)
systemprompt: p

systemprompt: 2

systemprompt: 20 (Start cylinder for second partition.)
systemprompt: 2018 (End cylinder for second partition. Must agree with Step 5 above.)
Command: t (Set the partition type.)
systemprompt: 2

systemprompt: 82 (Linux swap partition.)
Command: n (Create third new partition.)
systemprompt: p

systemprompt: 3

systemprompt: (Enter start cylinder for third partition or use default.)
systemprompt: (Enter end cylinder for third partition. Use remaining space on disk.)
Command: t (Set the partition type.)
systemprompt: 3

systemprompt: fd

Command: p (Print partition table. Must agree with good drive from Step 5 above.)
Command: w (Write new partition table.)
Command: q 

8. Create the RAID array. Type:
mdadm /dev/md0 -a /dev/sda1

mdadm /dev/md1 -a /dev/sda3

9. Type cat /proc/mdstat to monitor the progress. Repeat this step until RAID 
reconstruction is complete. The output will include a percent complete and estimated 
time to completion. Note the percent complete and estimated time to completion for md0 
and md1. If you wish to continue streaming from the VOD server while the RAID 
rebuilds, leave the build rate as is (about 30 hours in this example). If the system is offline 
and you wish to hasten the RAID rebuild, type:
echo "30000" > /proc/sys/dev/raid/speed_limit_min

Note that doing this on a system that is being actively used can affect streaming 
performance. After the rebuild is complete, type the following or reboot the VOD server 
to restore the default rebuild rate:
echo "1000" >/proc/sys/dev/raid/speed_limit_min 

10. Create the boot partition in the newly installed drive.
[root@NXG1 root]# grub

grub> root (hd0, 0)

grub> setup (hd0)

grub> quit
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Replacing Failed Drive2
Replacing a failed Drive2 is basically an identical procedure. The only difference is that the 
drive letters are reversed. For example, instead of typing:
fdisk /dev/sdb (See Step 5a in Replacing Failed Drive1.)
fdisk /dev/sda (See Step 5d in Replacing Failed Drive1.)

you would type:
fdisk /dev/sda

fdisk /dev/sdb

Similarly, for the mdam commands (See Step 8 in Replacing Failed Drive1), instead of typing:
mdadm /dev/md0 -a /dev/sda1

mdadm /dev/md1 -a /dev/sda3

you would type:
mdadm /dev/md1 -a /dev/sda3

mdadm /dev/md0 -a /dev/sda1

Similarly, for the grub commands (See Step 10 in Replacing Failed Drive1), instead of typing:
grub> root (hd0, 0)

grub> setup (hd0)

you would type:
grub> root (hd1, 0)

grub> setup (hd1)

Replacing a Failed RAID5 Drive
To replace a failed drive in a RAID5 array:

1. Power down. Type init 0 and wait for the system to shut down.
2. Remove failed drive from the system.
3. Add a replacement drive.
4. Power up and login as root.
5. Add the new drive to the array as follows: mdadm raid-device -a <drive>. For 

example, to add /dev/sdd back to the raid device /dev/md5, type
mdadm /dev/md5 -a /dev/sdd.

6. Type cat /proc/mdstat to observe the state of the RAID rebuild. For example:

[root@NXG2-2850 root]# mdadm /dev/md5 -a /dev/sdd
mdadm: hot added /dev/sdd
[root@NXG2-2850 root]# cat /proc/mdstat
Personalities : [raid1] [raid5]
md7 : active raid5 sdn[0] sdt[6] sds[5] sdr[4] sdq[3] sdp[2] sdo[1]
      860247552 blocks level 5, 128k chunk, algorithm 2 [7/7] [UUUUUUU]
md6 : active raid5 sdg[0] sdm[6] sdl[5] sdk[4] sdj[3] sdi[2] sdh[1]
      860247552 blocks level 5, 128k chunk, algorithm 2 [7/7] [UUUUUUU]
md5 : active raid5 sdd[4] sdc[0] sdf[3] sde[2]
      430123776 blocks level 5, 256k chunk, algorithm 2 [3/4] [USUU]
      [>....................]  recovery =  0.0% (5376/143374592) 

finish=1769.9min speed=1344K/sec
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md1 : active raid1 sdb3[1] sda3[0]

      123828928 blocks [2/2] [UU]

md0 : active raid1 sdb1[1] sda1[0]
      152512 blocks [2/2] [UU]
unused devices: <none>
[root@NXG2-2850 root]#

Note the percent complete and estimated time to completion for md5. If you wish to 
continue streaming from the VOD server while the RAID rebuilds, leave the build rate as is 
(about 30 hours in this example). If the system is offline and you wish to hasten the RAID 
rebuild, type:
echo "30000" > /proc/sys/dev/raid/speed_limit_min   
Note that doing this on a system that is being actively used can affect streaming performance. 
After the rebuild is complete, type the following (or reboot the VOD server to restore the 
default rebuild rate):
echo "1000" >/proc/sys/dev/raid/speed_limit_min

Best Practices
• The system bootup messages (including SCSI and RAID related messages) can be viewed 

by typing more /var/log/dmesg
• You can find where video content is stored by going directly to the Kasenna Content 

Administration web page and clicking on the Video Find/Modify link. Then click on the 
Find button to bring up a listing of all the stored video content. If you then click on the 
underlined video name, it will show you where the video files are stored, either under /
content (internal storage) or /external1 or /external2 (external storage).

ES3/4 Status LEDs

Front Panel LEDs
The LEDs on the front panel on the ES3/4 provide useful information to indicate how the 
system is operating.
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Hard Drive LEDs
Each hard drive has two LED indicators. A red busy indicator indicates the hard drive is 
active on the SCSI bus. The green and amber status indicator indicates the drive is not active.
Table 2.  LED Patterns

Power Supply LEDs
The Power Supply and Cooling Module LED Features and Indicators are shown below.

• Power LED indicator: At least one power supply is supplying 
power to the system.

• Shelf-fault LED indicator: One of the following conditions 
has occurred: power-supply failure, EMM failure, cooling-
module failure, over-temperature condition.

• Cluster LED indicator. Not used by VBrick.
• Split-bus LED indicator. Not used by VBrick.
• Over-temperature LED indicator. An over-temperature 

condition has occurred (the system will shut down when the 
temperature inside the box exceeds 122 °F.

Condition Pattern

Slot empty, ready for 
insert/remove

Off.

Drive online, prepare 
for operation

Steady green.

Drive identify Flashes green four times per second.

Prepare for removal Flashes green twice per second at equal intervals.

Drive rebuild Flashes green twice per second at unequal intervals.

Drive failure Flashes amber four times per second.

Predicted failure Flashes green, then amber, then off, repeating this sequence every 
two seconds. Predicted Failures are based on industry standard 
SMART (Self Monitoring Analysis and Reporting Technology) 
monitoring software which is built into every drive in the array.
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Table 3.  Power Supply and Cooling Module LED Indicators

1. Blower A fault LED indicator.
2. Blower B fault LED indicator.
3. On/Off switch.
4. AC connector.
5. AC status LED indicator.
6. Fault LED indicator.
7. Power-on LED. indicator.
8. Cooling module.

Module Icon LED Indicator LED Icon Function

Power supply Power on (green) DC output voltages are within specifications.

Fault (amber) One of the DC output voltages is not within 
specifications.

AC status (green) AC input voltage is within specifications 
regardless of the position of the power switch.

Cooling 
module

Blower A fault 
(amber)

Cooling module blower A has failed.

Blower B fault 
(amber)

Cooling module blower B has failed.
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Chapter 5

Ingesting Content
Video content added to a NXG1 or NXG2 VoD server goes through a transformation 
process known as ingestion. This process takes the original source MPEG video file and 
generates additional "trick" files which are used for indexing, fast forward, and rewind. These 
files are managed by an internal SQL database on the NXG which is used to keep track of all 
the trick files associated with a single piece of video content. This chapter describes the 
process of ingestion and its impact on data storage, content backup and recovery.

Topics in this chapter

Content Ingestion
Best Practices

Content Ingestion
Before the ingestion process begins, the video content must physically reside on the NXG 
server. In most cases, this file transfer is handled automatically by the EtherneTV Portal 
Server, although users may also opt to manually upload content to the NXG. In a typical 
scenario, after recording a piece of video content, the Portal Server automatically FTPs            
the video to a temporary staging area on the NXG and kicks off the ingestion process. 
Ingestion is a software process that runs in the background on the NXG server and may take 
place even while the NXG is serving up a large number of simultaneous video streams. 
Depending on the size of the video asset and overall NXG server load, the ingestion process 
may only take a few minutes or more than an hour. Once the Portal Server driven ingestion is 
complete, the original source video file held in the NXG’s disk staging area is deleted.
For MPEG-1 or MPEG-2 content, a total of 8 or 11 supplemental trick files (respectively) are 
generated in addition to the main or original video asset. During normal playback, the actual 
file streamed by the VoD server is the main MPEG asset. However, when the remote client 
hits the Fast Forward (or Rewind) button on his player or Set Top Box, the VoD server gets 
the FF command and uses the accompanying Fast Forward index, map, and main files to 
locate the proper position in the video and begin a Fast Forward stream. Rewind works in a 
similar fashion. Without these supplement trick files, viewers would be limited to basic play, 
pause, and stop commands.
All ingested video content on the NXG is stored in a special /content directory on the server 
which is managed by the MediaBase VoD software application. When additional external 
storage is added to the NXG, MediaBase can manage content residing here as well, under the 
directory names of /content2 and /content3 (NXG1) or /external1, /external2, /
external3, or /external4 (NXG2). The table below shows the actual MediaBase trick files 
created under the /content directory for a single MPEG-2 video asset, Sample1.mpg.
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In this example, the Main Asset, Sample1.mpg is stored in the /content/00/00/00 directory 
under the file name "af", with the associated trick files named "b0" through "ba". Note that 
for MPEG-1 and MPEG-2 assets, the Main Asset file is an identical copy of the original 
source video MPEG file. For MPEG-4 content, however, this is not the case as the Main 
Asset gets modified by MediaBase and the original source video MPEG-4 file cannot be 
derived from that file. If desired, the NXG administrator may get a listing of all the trick files 
for a video asset by going directly to the Kasenna MediaBase Content Administration web 
page, selecting the Video, Find/Modify link, and clicking on the video asset hyperlink Name. 
Some additional storage overhead is incurred by the file ingestion process, although the net 
increase is nominal. The following table shows the total number of stored files and added 
overhead for each type of MPEG video asset.

A small percentage of users may not need the NXG’s Fast Forward or Rewind capabilities and 
may wish to trade this capability for an increase in disk space. In this case, the administrator 
can add content via the Kasenna MediaBase web interface instead of using the more 
convenient Portal Server approach. On the MediaBase Content Administration web page, the 
administrator can go to the Add Video page, click on the Detail button and select the Add 
Support for Play Only option (in comparison with the default Play, Fast Forward, Rewind 
and Positioning option ) to choose this method.

 File Type File Name and Location

Main Asset /content/00/00/00/af 

MPEG Index /content/00/00/00/b0

MPEG MAP /content/00/00/00/b1

MPEG FF /content/00/00/00/b2

MPEG FF Index /content/00/00/00/b3

MPEG FF MAP /content/00/00/00/b4

MPEG REW /content/00/00/00/b5

MPEG REW Index /content/00/00/00/b6

MPEG REW MAP /content/00/00/00/b7 

MPEG SEQ Header /content/00/00/00/b8

MPEG PAT /content/00/00/00/b9

MPEG PMT /content/00/00/00/ba

MPEG Type Total File Disk Storage Overhead

MPEG-1 8 17%

MPEG-2 12 17%

MPEG-4 3 Negligible (less than .1%)
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Content Backup and Recovery                                                                                                
The ingestion process has some implications related to content backup and recovery that 
system administrators need to keep in mind. VBrick strongly recommends that all stored 
NXG video content get backed up onto an external storage system, typically an external disk 
array like a Vbrick ES3 or ES4 storage array, a Storage Area Network (SAN) or a tape backup 
system. Backing up the ingested video content onto an external system is insurance against 
the failure of one of the NXG1 or NXG2 internal disk drives. Since the backed up content is 
stored in "post-ingested" form (the main asset plus all associated trick files), content recovery 
is rapid and straightforward. Both the NXG1 and NXG2 also automatically backup the 
MediaBase SQL database each evening, so that recovery from disk failure is a relatively 
straightforward process of replacing the failed disk, rebuilding the Linux file system, and 
restoring the SQL database and video content.
If a system administrator does not have a disk backup system in place, however, then video 
content restoration is a more time consuming and labor intensive process. Each piece of 
video content must first be FTPed or copied onto the NXG server and then re-ingested from 
its original source file. If a customer has loaded several hundred hours of video content on 
their NXG system over the course of a year, then this manual recovery process could take 
many hours or even days to complete.
As described in the section above, it is possible to replicate the original piece of MPEG-1 or 
MPEG-2 video content from the stored Main Asset, although locating and copying the 
proper file can be time consuming if more than a few files are involved. Due to the file format 
used with MPEG-4, however, this replication is not possible. VBrick also recommends that 
administrators keep a copy of their original MPEG content in digital form on some archival 
media like CD-ROM or DVD, especially if they don’t have a robust backup system in place.

Best Practices
• If problems are encountered during file ingestion, the likely cause is a faulty or corrupted 

source file. All MPEG-2 source files must be recorded and saved as transport streams—
not program streams. Suspected problem files can be checked with a standalone player 
like StreamPlayer for verification.

• The NXG server maintains a log file of all successful or attempted file ingestions. If a file 
ingestion fails, the /usr/ocs/logs/mbaselog.local file can be examined for hints as to 
why the file ingestion failed.

• After adding a new video to the EtherneTV system using the Portal Server, it may take up 
to 30 minutes after ingestion before the new video appears in the Portal Server content 
directory. This is normal behavior.                                                                                                     

• If adding new video content to the NXG using the MediaBase interface, make sure you 
select the proper MPEG encoding (MPEG-1, 2, or 4) to match your source file, 
otherwise ingestion will fail.

• MediaBase provides a built-in Video Access utility to verify if a video asset can 
successfully accessed. This utility is found under the Kasenna MediaBase web page, 
Service Administration, Test, Video link. To use this utility, browse to or type in the fully 
qualified name of the ingested video asset and click on the "test" button. A successful test 
will return the video duration, movie Type (MPEG type), and the message "able to open 
the video for playing".



34 © 2005 VBrick Systems, Inc.

• You can find where video content is stored by going directly to the Kasenna Content 
Administration web page and clicking on the Video Find/Modify link. Then click on the 
Find button to bring up a listing of all the stored video content. If you then click on the 
underlined video name, it will show you where the video files are stored, either under /
content (internal storage or /content2 (external storage). 
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